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READ AND SAVE THESE INSTRUCTIONS. Follow the instructions in this installation man-
ual. These instructions must be followed to avoid damage to this product and associated equipment.
Product operation and reliability depends upon proper installation.

DO NOT INSTALL ANY SIMPLEX PRODUCT THAT APPEARS DAMAGED. Upon
unpacking your Simplex product, inspect the contents of the carton for shipping damage. If damage
is apparent, immediately file a claim with the carrier and notify an authorized Simplex product
supplier.

ELECTRICAL HAZARD - Disconnect electrical field power when making any internal
adjustments or repairs. Servicing should be performed by qualified Simplex representatives.

STATIC HAZARD - Static electricity can damage components. Therefore, handle as follows:

•  Ground yourself before opening or installing components.

•  Prior to installation, keep components wrapped in anti-static material at all times.

EYE SAFETY HAZARD - Under certain fiber optic application conditions, the optical output of
this device may exceed eye safety limits. Do not use magnification (such as a microscope or other
focusing equipment) when viewing the output of this device.

RADIO FREQUENCY ENERGY - This equipment has been tested and found to comply with the
limits for a Class A digital device pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instruction manual, may cause harmful inter-
ference to radio communications. Operation of this equipment in a residential area is likely to cause
harmful interference in which case the user will be required to correct the interference at his own
expense.

SYSTEM REACCEPTANCE TEST AFTER SOFTWARE CHANGES - To ensure proper
system operation, this product must be tested in accordance with NFPA-72, after any programming
operation or change in site-specific software. Reacceptance testing is required after any change,
addition or deletion of system components, or after any modification, repair or adjustment to sys-
tem hardware or wiring.

All components, circuits, system operations, or software functions known to be affected by a
change must be 100% tested. In addition, to ensure that other operations are not inadvertently
affected, at least 10% of initiating devices that are not directly affected by the change, up to a
maximum of 50 devices, must also be tested and proper system operation verified.

Cautions and Warnings
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Chapter 1. Introduction

Introduction This publication describes how to operate the Simplex® TrueSite™ Workstation, a PC-based
application that provides head-end annunciation, floor plan display, system control and information
management. 

The TrueSite Workstation is an integral part of an alarm system; it is a node on a Simplex Fire
Network used to annunciate and control the points contained within the network. If you install an
additional network interface cards (NIC), you can control up to four networks from one common
TrueSite Workstation. The TrueSite Workstation Run-time software is a Microsoft Windows®-based
application that makes it easy for operators to respond to system events such as active alarms and
trouble conditions.

Note: The TrueSite Workstation Banner is visible at all times.  If there is an active alarm or trouble in
the system, the banner will display a flashing indicator with an alarm count.

Referenced 
Documents

Configuration Before operating the TrueSite Workstation, configure the application by following the instructions in
the Simplex TrueSite Workstation Configuration Instructions - 579-844.

Notice to Users, 
Installers, 
Authorities Having 
Jurisdiction, and 
Other Involved 
Parties

This product incorporates field programmable software. In order for the product to comply with
the Standard for Control Units and Accessories for Fire alarm systems, UL864, certain
programming features or options must be limited to specific values or not used at all as indicated
below.

Document Number Title

579-834 Simplex TrueSite Workstation Installation & Checkout Instructions

579-844 Simplex TrueSite Workstation Configuration Instructions

579-838 Simplex 4190 TrueSite Workstation Software Upgrade Instructions

Program Feature or Option: Permitted in 
UL864? (Y/N) Possible Settings Settings  Permitted by 

UL 

Runtime Access Levels/
System-wide Functions/Quiet 
PC

Yes Settings  0 through n-1 (when 
logged on at access level n)

1-7 (If Global 
Acknowledge); 
7 (If Individual 
Acknowledge)
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Before You Log On Note: In the majority of cases, the TrueSite Workstation will be configured to start automatically
along with the station. This section concerns only the case when the TrueSite Workstation is
not configured for auto-start.

If the TrueSite Workstation is not configured to start automatically, then there are two ways for you to
access the TrueSite Workstation:

• Through the start menu, launch TrueSite Workstation by clicking Start -> All Programs ->
Simplex -> TrueSite -> TrueSite Workstation -> TrueSite Workstation (Figure 1-1).

 Figure 1-1    Launching TrueSite Workstation from Start Menu

• Alternatively, you may double-click the TrueSite Workstation icon from your desktop (Figure 1-2).

 Figure 1-2    Launching TrueSite Workstation from Icon

Note: If the system is already programmed, you can immediately begin operating the TrueSite
Workstation. If the system is not yet programmed, you receive a message informing you that
there is an error when you load the database. If you receive this type of message, refer to the
TrueSite Workstation Installation & Checkout Instructions - 579-834 and ensure that the
system is programmed as desired.

After you select TrueSite Workstation, the Login dialog appears. You must provide username and
passcode to log on.

Continued on next page

Before You Can Operate the TrueSite Workstation
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Before You Can Operate the TrueSite Workstation, Continued

Log On Note: This section is also covered in Chapter 6.

 Figure 1-3    Login Dialog

To log on:
1. In the Login dialog (Figure 1-3) provide the following information:

a. Enter your name/number using the digit buttons on the right.
b. Enter your passcode using the digit buttons on the right.

2. After completing these two fields, click Log On.
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Chapter 2. TrueSite Workstation Graphical 
User Interface

Introduction The TrueSite Workstation graphical user interface (GUI) provides you with the ability to control
network points, and to configure audiovisual annunciating options. This chapter provides listings of
all TrueSite Workstation commands available to you, with an emphasis on describing its interface
structure. You can use this section as a reference guide for specific commands accessible through the
GUI. The subsequent chapters will describe the nature of these commands in more detail.
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Activating Options

Three Methods 
Used to Activate 
Options

You can activate options by using any one of three methods. If available for your system, you can use
a touchscreen or a mouse. If not, you can use the keyboard to activate options. 

Note: 1. If you click Help while you are activating an option, the Help command brings up informa-
tion about the particular option you are activating.

     2. Alternatively, you may access the Help command by pressing F1 on your keyboard.

Using the 
Touchscreen to 
Activate Options

If your system has a touchscreen, you can simply use your finger to press the area of the screen you
wish to activate. 

Caution: There is a thin sensing layer on the surface of the touchscreen. When pressing the 
screen, be careful not to crease this layer with your fingernail. If this layer is creased, the 
touchscreen may not function properly.

After you press the desired area, the commands under that option are made available to you.

Using the Mouse to 
Activate Options

If your system has a mouse, you can simply click the area of the screen you wish to activate. After
you click the desired area, the commands under that option are made available to you. 

Using the 
Keyboard to 
Activate Options

The TrueSite Workstation is a PC-based product that comes with a keyboard. Use the keyboard to
activate options by using the arrow keys to move to the area of the screen you wish to activate. You
can also use the Tab key to move forward through the possible options and the Shift and Tab key
combination to move backwards through the possible options. When you are at the area of the screen
you wish to activate, press the Enter key and the commands under that option are made available to
you.
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Graphical User Interface

GUI Layout The TrueSite Workstation Run-time interface (Figure 2-1) has a layout composed of the following
blocks:
• system wide banner
• system status bar
• system menubar
• toolbars
• main window
• major tab area
• lower tab area

 Figure 2-1    TrueSite Workstation GUI

Continued on next page

Main window

System
menubar

System wide banner

System status bar

Toolbars

Major
tab area

Lower
tab area
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Graphical User Interface, Continued

System Wide 
Banner

The system wide banner (Figure 2-2) is always visible at the top of the screen. It lists the current
alarm counts per alarm category; category buttons will flash when unacknowledged alarms exists.

Note: When the system is normal, the buttons in the system wide banner do not appear.

 Figure 2-2    TrueSite GUI System Wide Banner (with trouble)

System Menubar Through the system menubar, several menus are available by default:
• File
• View
• Utilities
• Help

The following menus are available when a specific window is selected in the major tab area:
• Network - displays when Network tab is selected
• Graphics - displays when Graphics tab is selected
• Operations - displays if Alarm List or Status & Control tabs is selected
• Report - displays when Report tab is selected
• Historical Log - displays when Historical Log tab is selected

Toolbars

 Figure 2-3    TrueSite Workstation Toolbar Menu

Selected toolbars are usually displayed below the system menubar (Figure 2-3). The following is a list
of toolbar menus:
• File
• View
• Utilities
• Operations
• Graphics
• Historical Log
• Reports
• Network

Continued on next page
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Graphical User Interface, Continued

Toolbars, Continued Table 2-1 lists the available commands under each toolbar menu.

Major Tab Area The major tab area lists all the active tabs and allows you to switch different views to display in the
main window area.

Note: You can switch between major tabs in the TrueSite Workstation using Ctrl +Tab.

Main Window The main window displays the active screens. This is the area where you can view and select alarms
and points lists to administer the system.

Note: Refer to Chapter 4 of this document for detailed descriptions of all major screens.

You can set the main window to the following states by right-clicking any window in the main
window area:
• Floating - You can set any of the active screens to the following states by right-clicking in the 

major tab area: when running a dual-monitor setup, a floating window can be moved to the sec-
ond screen. (Refer to TrueSite Workstation Installation & Checkout Instructions - 579-834 for 
details on extending your Windows XP desktop to a second monitor.) One typical use for this 
feature is to provide you with the ability to view the main TrueSite Workstation Run-time on the 
first monitor while the Graphics window is fully displayed on a second monitor.

• Dockable - This enables several docked windows to display simultaneously in the main window 
area.

• Fixed - Window takes up the entire main window area by default.
• Hidden - Window is not displayed.

Minor Tab Area The minor tab area lists all the available tabs within a specific major tab and allows you to switch
different views to display in the main window area.

Note: You can switch between minor tabs in the TrueSite Workstation using Shift +Tab.

Table 2-1: Toolbar Commands List

File View Utilities Operations Graphics
History and 

Operator 
Logging

Report Network
Status

(bottom of 
screen)

•Open
•Restart
•Print
•Preferences
•Exit

•Alarm Lists
•Points Status 
& Control

•Graphic Floor 
Plans

•Report
•History & 
Operator Log-
ging

•Control Win-
dows

•List Help 
Topics

•Login
•Time & Date
•Configurator
•Network
•Site Info
•Point Simu-
late

•Quiet Sounder
•Restore All 
Windows

•Alarm Silence
•System Reset
•Enable/Dis-
able

•Action Mes-
sage

•View Point 
Graphic

•Change Status
•Find
•Filter
•Find Next
•Select Loop

•Load Graphic
•Zoom Win-
dow

•Pan Window
•Zoom In
•Zoom Out
•Whole Win-
dow

•Zoom Previ-
ous

•Print

•Change View
•Change Vol-
ume

•Volume Oper-
ation

•Operator 
Notes

•Find
•Find Next

•Generate
•View
•Close View
•Terminate
•Printer Con-
trol

•Topology
•Attendance
•Select Loop
•Host Diagnos-
tics

•Prompt Area
•Run-time-
Header Area

•Operator 
Name Area

•Time/Date 
Area
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Graphical User Interface, Continued

System Status Bar The system status bar always displays at the bottom of the main window. It is not moveable/dockable.
The Status Bar will contain the following panes:
• Prompt area (changes based on state of the system)
• Run-time-Header (line 1) area – display Run-time-Header Line 1 (from GenInfo in DBF)
• Run-time-Header (line 2) area – display Run-time-Header Line 2 (from GenInfo in DBF)
• Operator Name area – displays current login/operator
• Time/Date area – displays current time/date: 

• The Time format shall be HH:MM:SS [AM/PM] – AM/PM is not displayed in 24 hour mode
• The default Date format shall be DAY DD-MON-YY (e.g, TUE 11-APR-06). For Chinese 

systems, the Date format shall be DAY YY-MON-DD (language determined from SOS.INI)
• The same Time/Date formats shall be used throughout the TrueSite Workstation
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Chapter 3. File Menu

File Menu 
Commands 
Summary

The File menu as shown in the menubar and the toolbar in Figure 3-1, allows you to perform the
following basic commands:
• Opening an existing job
• Restarting TrueSite Workstation application
• Setting display preferences
• Printing reports
• Exiting TrueSite Workstation application

 Figure 3-1    File Menu from Menubar and Toolbar Views

File menu
from menubar

File menu from toolbar
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Open

Overview Note: Before you can select a job from a list of available nodes, you must first configure the job and
build it using the TrueSite Workstation Configurator. Refer to TrueSite Workstation
Configuration Instructions - 579-844 for detail.

The Open button (Figure 3-2) allows you to select the active job from a list of available nodes within
a specific network.

 Figure 3-2    Open Button

Note: Alternatively, you may access the Open command by pressing Ctrl + O on your keyboard.

Opening an 
Existing Job

To open an existing job:

1. Open the File menu. You may do so by either activating the File toolbar or by clicking File from
the menubar.

2. From the Job Selection dialog box (Figure 3-3), click Select Network button at the bottom left.

 Figure 3-3    Job Selection Dialog

Continued on next page
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Open, Continued

Opening an 
Existing Job, 
Continued

3. The Network Selection dialog box appears as shown in Figure 3-4 with a list of configured sites.
Select and highlight the site from which you want to load the job and then click OK. The
Network Selection dialog closes.

 Figure 3-4    Network Selection Dialog

Note:  Selecting a job from a different network involves a TrueSite Workstation restart before 
it is actually loaded.

4. After selecting the site, a list of jobs related to the corresponding site appear listed in the Job
Selection dialog box as shown in Figure 3-5.

 Figure 3-5    Job Selection Dialog with Loaded Jobs List

5. Highlight and select the job you want to load from the Job selection dialog and click OK.
6. The job is loaded.
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Restart

Overview The Restart button (Figure 3-6) allows you to re-initialize the system. This command will clear point
states and counts, and restart the TrueSite Workstation.

 Figure 3-6    Restart Button

Note: Alternatively, you may access the Restart command by pressing Ctrl + R on your keyboard.

Restarting the 
System

To restart the system:

1. Open the File menu. You may do so by either activating the File toolbar or by clicking on File
from the menubar.

2. From the list of commands displayed, click Restart. 
3. TrueSite Workstation will issue a Restart Confirmation prompt (shown in Figure 3-7) for you to

confirm your decision to restart. 
• To go along with the restart operation, click OK to confirm. 
• Otherwise, you may click Cancel to quit the operation without restarting the application.

 Figure 3-7    Restart Confirmation Prompt
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Preferences

Overview The Preferences button (Figure 3-8) allows you set TrueSite Workstation display preferences listed
in Table 3-1.

 Figure 3-8    Preferences Button

Continued on next page

Table 3-1: Preferences Display Options

Settings Options

Font Size Default

Large

Toolbar Size Small

Large

User Interface Theme MS Office 2003

System

Floating Windows Show Menubar

Show Toolbars

Application Mode Captive Environment

Allow Other 
Application to Run
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Preferences, Continued

Accessing the 
TrueSite 
Workstation 
Preferences Dialog

To be able to set the display preferences, you must first access the TrueSite Workstation Preferences
dialog. Follow this procedure:

1. Open the File menu. You may do so by either activating the File toolbar or by clicking on File
from the menubar.

2. From the list of commands displayed, click Preferences. A TrueSite Workstation Preferences
dialog appears (Figure 3-9). From this point, you may select the display preferences.

 Figure 3-9    TrueSite Workstation Preferences Dialog

Setting Font Size From the TrueSite Workstation Preferences dialog, you may select one of two Font Size options by
checking the radio button of the corresponding selection. Figure 3-10 shows the font difference
between the Default and Large options.

 Figure 3-10    Default Versus Large Font Size

Note: The Large font setting applies to touchable controls (e.g. buttons, menu items, grid rows, etc)
This option will be used most for touchscreen users.

Continued on next page

Default
fonts

Large
fonts
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Preferences, Continued

Setting Toolbar 
Size

From the TrueSite Workstation Preferences dialog, you may select one of two Toolbar Size options
by checking the radio button of the corresponding selection. Figure 3-11 shows the difference
between the Small Toolbar and the Large Toolbar.

 Figure 3-11    Small Toolbar Versus Large Toolbar

Selecting User 
Interface Theme

From the TrueSite Workstation Preferences dialog, you may select one of two User Interface Theme
options by checking the radio button of the corresponding selection. Figure 3-12 shows the difference
between the MS Office 2003 and System themes.

 Figure 3-12    MS Office 2003 Versus System Theme

Note: The System theme is set based on the theme that is installed on your operating desktop
(Windows XP). The Windows XP "Silver" color scheme should not be used with TSW -
highlighting/flashing of colors does not work properly with the Silver color scheme.

Setting Floating 
Windows Options

From the TrueSite Workstation Preferences dialog, set floating windows options for the menubar and
the toolbars. Select or deselect the checkboxes next to Show Menubar and/or Show Toolbars. This
determines whether or not the menubar and toolbars will be shown under floating window conditions.

Continued on next page

Small toolbar
Large toolbar

MS Office 2003 theme

System theme
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Preferences, Continued

Setting Application 
Mode

From the TrueSite Workstation Preferences dialog, set Application Mode to one of the two settings:
• Captive Environment (full screen) - environment which does not allow you to switch to other 

applications until you exit from the system
• Allow Other Applications to Run

WARNING: Non-captive mode should only be used for applications where operation of the TrueSite
Workstation is supplemental to the proper operation of the fire alarm system.  In non-captive
mode the operation and response of the TrueSite Workstation to fire alarm incidents could be
adversely affected by the other programs running under Windows.

Note: 1. If the “Captive Mode Supported” system option is disabled, the application mode will 
always stay non-captive.

     2. Before changing from a non-captive user to a captive user, be sure to close any other win-
dows applications that may be running.
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Print

Overview The Print button (Figure 3-13) allows you to print the system screen from the printer.

 Figure 3-13    Print Button

Note: Alternatively, you may access the Print command by pressing Ctrl + P on your keyboard.

Printing To print from a printer:

1. Open the File menu. You may do so by either activating the File Toolbar or by clicking on File
from the menubar.

2. From the list of commands displayed, click Print. 

Note: In order to use the TSW Print option, you must add a printer to your job via the configurator.
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Exit

Overview The Exit button (Figure 3-14) allows you exit the TrueSite Workstation application.

 Figure 3-14    Exit Button

Exiting the 
Application

To quit TrueSite Workstation application:

1. Select the File menu. You may do so by either activating the File Toolbar or by clicking on File
from the menubar.

2. From the list of commands displayed, click Exit.
3. An Exit prompt dialog box displays a warning that upon exit, the node will be taken offline.

Click OK to confirm.

 Figure 3-15    Exit Prompt Dialog
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Chapter 4. View Menu

View Menu 
Commands 
Summary

The View menu as shown in Figure 4-1 provides access to the following view options in the main
window:
• Alarm Lists
• Points Status & Control
• Graphics
• Reports
• Historical Log
• Control Windows
• Help

 Figure 4-1    View Menu from Menubar and Toolbar Views

Note: The Help operation is present in the View toolbar but not in the View menubar. A stand-alone
help menubar provides the operator with access to all operations relating to the contextual
online help.

View menu
from menubar

View menu from toolbar
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Alarm Lists

Overview The Alarm Lists button (Figure 4-1) allows you to view and acknowledge alarm signals within the
Alarm Lists tab. An alarm list displays information that tells the operator when a point changes
states.

 Figure 4-1    Alarm Lists Button

Notes: 1. Alternatively, you may access the Alarm Lists command by pressing F5 on your key-
board.

     2. The Operations toolbar menu provides commands relating to the Alarm Lists window. 
Refer to Chapter 5 of this document for a description of the operations listed below.

Alarm Lists 
Window

 Figure 4-2    Alarm Lists Window

Continued on next page
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Alarm List, Continued

Alarm Lists 
Window, Continued

From the Alarm Lists Window (Figure 4-2), you can click on the alarm type tabs at the bottom-left of
the main window to view the list of current alarms in one of these four types of alarms:
• Fire Alarm
• Priority 2 Alarm
• Supervisory
• Trouble

Note: Each Alarmcategory can display up to 600 alarms at once.

The Alarm Lists window contains the following columns:
• Number - index in the alarm list (oldest first)
• Time - time at which an event has occurred for a specific point (HH:MM:SS)
• Date - date at which an event has occurred for a specific point (WWW DD-MM-YY)
• Event - short description of event
• Detail - point type
• Status - current status of a point

Acknowledging an 
Alarm

Notes: 1. An active alarm causes the banner to flash and triggers the PC sounder.

     2. Press F5 on your keyboard to bring up the list of active alarms. While viewing the alarms 
list, you can press F5 again to bring up the Acknowledge Box.

1. From the TrueSite Workstation main window, click on Alarm Lists tab among the selectable
tabs. 

2. As the list of alarms is displayed, you can browse through the alarm types by selecting their
corresponding tabs at the bottom-left of the main window. Each tab selection displays its own list
of alarms.

3. Once you find an unacknowledged (flashing) alarm signal, highlight the selected entry by
clicking it. An Acknowledge Box appears as shown in Figure 4-3. 

4. From the Acknowledge Box, you may do the following:

• Acknowledge the alarm
• Add an operator note to the alarm

 Figure 4-3    Acknowledge Box

Continued on next page
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Alarm Lists, Continued

Acknowledging an 
Alarm, Continued

5. Click Acknowledge. The alarm signal goes from flashing to non-flashing in the Alarm Lists.
6. The alarm remains displayed on the active Alarm Lists for as long as a point is in a non-normal

status.

Adding Operator 
Notes

To add an operator note, follow this procedure:

1. Follow steps 1 to 4 listed in the previous section.
2. From the Acknowledge Box, click Operator Notes. 
3. An Add Operator Note dialog appears as shown in Figure 4-4.
4. In the text field, compose a note you would like to include with the point.

 Figure 4-4    Add Operator Note Dialog

5. Once you have finished composing the note in the text field, click OK to add the note.
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Status & Control

Overview The Status & Control button (Figure 4-5) allows you to access the Points Status and Control
Window which contains a scrollable list of entries to all points in the system. From this window, you
can view the status of points within the network, and configure their settings.

 Figure 4-5    Status & Control Button

Note: Alternatively, you may access the Status & Control command by pressing F10 on your
keyboard.

Status & Control 
Window

Note: When the Status and Control tab is selected in the main window area, the Operations toolbar
menu automatically becomes available.

 Figure 4-6    Point Status & Control Window

Continued on next page
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Status & Control, Continued

Status & Control 
Window, Continued

The Status & Control grid contains the following columns:
• Point Name - unique identifier that is specific to a point
• Description - a short description of a point
• Point Type - type of point
• Status - status that changes only for each point

Note: When a DACR point exists, the following additional information is also displayed:

•  Acct

•  Group

•  CID Number

Point & Status 
Window Operations

Note: The Operations toolbar menu provides commands relating to the Alarm Lists window. Refer
to Chapter 5 of this document for a description of the operations listed below.

From the Status & Control window, the following operations are available:
• Displaying the status of a point
• Changing the status of a point
• Finding a point
• Filtering the current list of points
• Viewing the point graphic
• Adding operator’s notes for a point
• Viewing operator’s notes for a point
• Viewing action messages associated with a point
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Control Windows

Overview The Control Windows button (Figure 4-7) activates the Control windows.

 Figure 4-7    Control Button

The Control window (Figure 4-8) displays custom control created by the operator using the TrueSite
Workstation Configurator.

 Figure 4-8    Control Windows

When the Control Windows major tab is selected, there are five options available in the minor tab:
• Utility
• Phone
• Standard audio
• Auxiliary audio
• Speaker audio

Continued on next page
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Control Windows, Continued

Utility The Utilities minor tab window (Figure 4-9) contains a dropdown box that lists all Utility Control
Screens defined for the current job. Each row displayed contains a point label. Next to each label is a
series of one or more buttons that can be used to perform control operations on a specified point.

 Figure 4-9    Utility Minor Tab

To perform a control operation on a point:
1. Click and select a utility control screen from the dropdown list.
2. A grid containing point labels and control buttons appear.
3. Click a button to perform an operation on a specified point.

Continued on next page
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Control Windows, Continued

Phone The Phone minor tab window displays rows of phone circuit representing incoming calls on remote
phones. Each row contains a phone circuit label. Next to each label are two color-coded buttons:
• ANSWER
• HOLD

Additionally, two general command buttons are available at the top of the grid. These operations
affect all phones.
• Answer All
• Call Out

Standard Audio The Standard Audio minor tab window (Figure 4-10) displays a empty grid by default. The buttons
displayed depend on the audio type and the number of channels:
• Manual Audio Evacuation (OFF, ON)
• Evacuation Message (OFF, ON)
• Local Speaker (OFF, ON EVAC)
• All Speakers Talk (OFF, ON)

 Figure 4-10    Standard Audio Minor Tab

Continued on next page
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Control Windows, Continued

Auxiliary Audio and 
Speaker Audio

The Auxiliary Audio and Speaker Audio minor tab windows display rows contains a point labels.
Next to each label is a series of one or more buttons that can be used to perform control operations on
a specified point. The buttons depends on which mode was used to create the audio control screen
entries and are color-coded.
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Graphics

Overview The Graphics button (Figure 4-11) allows you to open the default graphic page in the Graphic
Window if an initial graphic screen is specified for the job; otherwise, the Graphics Window will be
blank.

 Figure 4-11    Graphics Button

Notes: 1. Graphics are operator-defined and are programmable using the TrueSite Workstation Con-
figurator. Refer to publication TrueSite Workstation Configurator Instructions - 579-844 for 
detail on how to program graphics.

     2. Alternatively, you may access the Graphics command by pressing F11 on your keyboard.

 Figure 4-12    An Operator-defined Graphics Window

Normal View

After panning and
zooming in
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Graphics, Continued

Graphics Menu 
Options

The Graphics menu allows you to control the visual display of the Graphics window. As shown in
Figure 4-13, the following operations are available from this menu:
• Load Graphics
• Zoom Window
• Pan Window
• Zoom In
• Zoom Out
• Whole Window
• Zoom Previous
• Print

 Figure 4-13    Graphics Menu from Menubar and Toolbar Views

Notes: 1. To be able to access the Graphics toolbar menu, you must first activate it as follows: Right-
click the toolbar portion of the TrueSite Workstation interface. From the list of available tool-
bar menus, highlight and select Graphics Toolbar. The Graphics menu should display on 
the toolbar.

     2. TrueSite Workstation Run-time activates the Graphics toolbar menu whenever the Graph-
ics window is active in the main window area.

Load Graphics

 Figure 4-14    Load Graphics Button

The Load Graphics button (Figure 4-14) opens the Load Graphic dialog box from which you select a
graphic to open.

Graphics menu
from menubar

Graphics menu from toolbar
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Graphics, Continued

Zoom Window

 Figure 4-15    Zoom Window Button

Notes: 1. Either "Zoom Window" or "Pan Window" is always selected (not both); the selected option 
is highlighted/selected in the menubar/toolbar.

     2. Alternatively, you may access the Zoom Window command by pressing Ctrl + (arrow 
keys) on your keyboard to zoom in and out.

The Zoom Window button (Figure 4-15) allows you to select a zoom area in the Graphics window.
To do so, follow these procedures:

1. Click Zoom Window in the Graphics toolbar menu.
2. Using your mouse, place the pointer over the area of the Graphics window you want to view.

Then, left-click and drag.
3. The area you selected becomes the zoom area.

Pan Window

 Figure 4-16    Pan Window Button

Notes: 1. Either "Zoom Window" or "Pan Window" is always selected (not both); the selected option 
is highlighted/selected in the menubar/toolbar.

     2. Alternatively, you may access the Pan Window command by pressing the arrow keys (up, 
down, left or right) on your keyboard.

The Pan Window button (Figure 4-16) allows you to move along any direction in the Graphics
window. To do so, follow these procedures:

1. Click Pan Window button in the Graphics toolbar menu.
2. Using your mouse, place the pointer and left-click any area of the Graphics window.
3. Hold the mouse button and drag along any direction to pan the window. You should be able to

move the screen around to show different parts of the Graphics window.

Continued on next page
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Graphics, Continued

Zoom In / Zoom Out

 Figure 4-17    Zoom In / Zoom Out Buttons

The Zoom In and Zoom Out buttons (Figure 4-17) allow you to enlarge and shrink the displayed
screen in the Graphics window.
• To enlarge the displayed graphic by adding a factor of 0.25 to the current zoom level, click Zoom

In.
• To shrink the displayed graphic by subtracting a factor of 0.25 to the current zoom level, click

Zoom Out.

Whole Window

 Figure 4-18    Whole Window Button

Click on Whole Window button (Figure 4-18) to make the entire drawing to visible within the
dimensions of the Graphics window. 

Zoom Previous

 Figure 4-19    Zoom Previous Button

Click on Zoom Previous button (Figure 4-19) to restore the previous view resolution in the Graphics
window.

Print

 Figure 4-20    Print Button

Note: The Print operation is available only when a printer is added to the job using the Configurator.

Click on Print button (Figure 4-20) to print the current Graphics window screen to the configured
printer.
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Other Windows

Overview The remaining windows are accessible through the View toolbar menu. To access any of the
windows, click on their corresponding button in the View menu toolbar.

Reports Window The Report button (Figure 4-21) activates the Reports window.

 Figure 4-21    Report Button

 Figure 4-22    Reports window

Note: The Reports toolbar menu provides commands relating to the Reports window. Refer to
Chapter 8 of this document for details on the Reports toolbar menu.

Continued on next page
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Other Windows, Continued

Historical Log 
Window

The Historical Log button (Figure 4-23) activates the Historical Log window.

 Figure 4-23    Historical Log Button

 Figure 4-24    Historical Log Window

Notes: 1. The Historical Log toolbar menu provides commands relating to the Alarm Lists window. 
Refer to Chapter 7 of this document for details on the Historical Log toolbar menu.

     2. Alternatively, you may access the Historical Log command by pressing F12 on your key-
board.

Continued on next page
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Other Windows, Continued

Historical Log 
Window Operations

Note: The Operations toolbar menu provides commands relating to the Historical Log window.
Refer to Chapter 7 of this document for a description of the operations listed below.

From the Status & Control window, the following operations are available:
• Change View
• Change Volume
• Volume Operation
• Operator Notes
• Find
• Find Next

Help Window The List Help topics button (Figure 4-25) activates the Help window.

 Figure 4-25    Help Button

Note: You can press F1 to access a help file relating to any context within the TrueSite Workstation
Run-time.

 Figure 4-26    Help Window
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Chapter 5. Operations Menu

Introduction The Operations toolbar is displayed when the user enters the Alarm Lists window, the Point Status
and Control window, or the Simulate window. The following options are available through this
toolbar menu:
• Alarm Silence
• System Reset
• Enable/Disable
• Action Message
• View Point Graphic
• Change Status
• Find
• Find Next
• Filter
• Select Loop

 Figure 5-1    Operations Menu from Menubar and Toolbar Views

Notes: 1. To be able to access the Operations toolbar menu, you must first activate it as follows: 
Right-click the toolbar portion of the TrueSite Workstation interface. From the list of avail-
able toolbar menus, highlight and select Operations Toolbar. The Operations menu 
should display on the toolbar.

     2. By default, the TrueSite Workstation Run-time activates the Operations toolbar menu 
whenever the Alarm Lists window, the Point Status and Control window or the Point Simu-
late window is active in the main window area. You may choose to hide the toolbar menu. 
(Refer to Chapter 4 for more details on the Alarm Lists window and the Point Status and 
Control window.)

Continued on next page

Operations menu
from menubar

Operations menu from toolbar
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Alarm Silence

Overview The Alarm Silence button (Figure 5-2) allows you to silence an active alarm signal.

 Figure 5-2    Alarm Silence Button

Note: In order to use Alarm Silence, the proper list must first be populated using the Configurator.

Silence an Alarm Notes: 1. If there is an active alarm in the system, the banner flashes and the PC sounder is trig-
gered.

     2. The alarm lists remain visible whenever there’s an active alarm in the system.

To silence an active alarm, follow this procedure:
1. Click and highlight an active alarm from the Alarm List window or an active point from Point

Status and Control window.
2. After highlighting the active alarm source, click Alarm Silence in the Operations toolbar menu.
3. An Alarm Silence Confirmation dialog box appears as shown in Figure 5-3. Click Alarm Silence

in the confirmation dialog box.

 Figure 5-3    Alarm Silence Confirmation Dialog

4. The following message will display at the status bar at the bottom of the screen: “Alarm silence
is in progress.”

5. The status message disappears. The alarm is silenced.

Note: Silence will be indicated in the system status bar until the system resets or a resound occurs.
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System Reset

Overview The System Reset button (Figure 5-4) allows you to reset the system.

 Figure 5-4    System Reset Button

Note: In order to use System Reset, the proper list must first be populated using the Configurator.

Reset the System Note: You must activate either the Alarm List window or the Status and Point Control window in
order to reset the system.

To reset the system, follow these procedures:

1. Select and highlight an active alarm from the Alarm List window or an active point from Point
Status and Control window.

2. After selecting the active alarm source, click System Reset in the Operations toolbar menu.
3. A System Reset Confirmation dialog box appears as shown in Figure 5-5. Click System Reset in

the dialog box.

 Figure 5-5    System Reset Confirmation Dialog

4. The system is reset.

Note: System Reset progress is indicated in the system status bar.
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Enable/Disable

Overview The Enable/Disable button (Figure 5-6) allows you to enable and disable a point in the TrueSite
Workstation.

 Figure 5-6    Enable/Disable Button

Note: The Alarm List tab need not be selected in the major tab area to make the Enable/Disable
button usable.

Enable a Point To enable a point, follow these procedures:

1. Select and highlight a point from the Alarm List window.
2. After selecting the point, click Enable/Disable in the Operations toolbar menu.
3. An Enable Point Countdown dialog box appears. This dialog displays a dynamic text control that

reads “Point will enable in x seconds” from 10 to 0 seconds.
4. You may choose between the following course of events:

• Wait for the countdown to end.
• Click on Enable Immediate button to stop Enable Point Countdown.

Note: After step 4, the Disable/Enable dialog disappears. You will be unable to cancel the
operation.

5. The Enable Point command is sent to the panel. The dialog closes.

Disable a Point To disable a point, follow these procedures:

1. Select and highlight a point from the Alarm List window.
2. After selecting the point, click Enable/Disable in the Operations toolbar menu.
3. The Disable Point command is sent to the network. The dialog closes.
4. A trouble condition is created.
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Action Message

Overview The Action Message button (Figure 5-7) allows you to open and view point information from the
Action Message tab in Status & Control dialog box.

 Figure 5-7    Action Message Button

View Action 
Message

Note: You must activate either the Active List window or the Status and Point Control window in
order to use Action Message button.

To view action message information, follow these procedures:

1. Select and highlight an active alarm from the Alarm List window or an active point from Point
Status and Control window.

2. After making your selection, click Action Message in the Operations toolbar menu.
3. A Status & Control dialog box activated under Action Message tab appears as shown in Figure

5-8. The following information is displayed in this dialog:

• Node Name
• Custom Label
• Point Name
• Point Type
• DACR Account - Group - CID Number

 Figure 5-8    Status & Control Dialog, Action Message Tab
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View Point Graphic

Overview The View Point Graphic button (Figure 5-9) allows you to display the Graphic Window with the
screen containing the selected point.

 Figure 5-9    View Point Graphic Button

Note: You must activate the Point Status & Control window in order to use the View Point Graphic
button.

View Point 
Graphics

If the system is configured to support graphic screen display, clicking on View Point Graphics
button in the Operations toolbar menu will bring up the Graphics window. To do so, follow these
steps:

1. Select and highlight a point from the Point Status & Control window.
2. After selecting the active point, click View Point Graphic in the Operations toolbar menu.
3. The main window area displays a Graphics window with a screen containing the selected point

centered according to the Run-time custom zoom level.

Note: You can use the commands in the Graphics toolbar menu to control the viewing of points in
the Graphics window. Refer to Chapter 4 for more detail.
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Change Status

Overview The Change Status button (Figure 5-10) allows you to set the status of a point. The status of a point
can be set to either Normal or Abnormal.

 Figure 5-10    Change Status Button

Note: The Change Status button is usable only when the Point Status & Control tab is selected in
the major tab area. You must activate the Point Status & Control window or the Simulate
window in order to use the Change Status button.

Change Point 
Status

To change the status of a point, follow this procedure:

1. Select and highlight a point from the Point Control & Status window.
2. After selecting the point, click Change Status in the Operations toolbar menu.
3. A Status & Control dialog box appears with Status tab selected.
4. Select the Control tab to view the dialog as it is shown in Figure 5-11.

 Figure 5-11    Status & Control Dialog, Control Tab

5. Set a new status by clicking one of the available state selection categories:

• To set point status to Normal, click Normal ALARM.
• To set point status to Abnormal, click Abnormal ALARM.

6. To set a new point priority number, click on the up/down arrows next to the Priority text field to
increment or decrement its value. Valid inputs include all integer values between 0 and 15.



5-8

Find / Find Next

Overview The Find button (Figure 5-12) allows you to find a point in the Point Status & Control window.

 Figure 5-12    Find & Find Next Button

Notes: 1. The Find button is usable only when the Point Status & Control tab is selected in the 
major tab area. You must activate the Point Status & Control window in order to use the 
Find button.

     2. Alternatively, you can press Ctrl+F and F3 to access the Find and Find Next operations 
respectively.

Find a Point To change the find a point, follow these procedures:

1. Click the Point Status & Control tab in the major tab area to open it in the main window.
2. Click Find in the Operations toolbar menu.
3. A Find Point dialog box appears as shown in Figure 5-13. 

 Figure 5-13    Find Point Dialog

4. In the “Enter the point, label or text” field, enter your selection.
5. Click inside the Search Options dropdown box and select one of the three options listed below to

set the point search criteria.

• by point name or index (All Points)
• by point label (Current View)
• by all (Current View)

6. Once you have entered the search selection and conditions, click Find.
7. If there are any matches, results will be returned.
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Filter

Overview The Filter button (Figure 5-14) allows you to filter the display of the point list in the Point Status &
Control window.

 Figure 5-14    Filter Button

Note: The Filter button is usable only when the Point Status & Control tab is selected in the major
tab area. You must activate the Point Status & Control window in order to use the Filter
button.

Filter Points To filter points displayed in the Point Status & Control window, follow these procedures:

1. Click the Point Status & Control tab in the major tab area to open it in the main window.
2. Click Filter in the Operations toolbar menu.
3. A Point Filter dialog box appears as shown in Figure 5-15. 

 Figure 5-15    Find Point Dialog

4. Under the “Point Category” list, you can check or un-check any of the following checkboxes to
display or filter the corresponding content:

• Monitor
• Control
• Analog Pseudo
• Digital Pseudo
• List Pseudo
• Common Trouble
• Other

Notes: 1. To Check the entire list of options, click Select All.

     2. To Un-check the entire list of options, click Un-select All.

5. Click OK to confirm selections.
6. The Point Status & Control window will update to filter out unselected categories.
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Select Loop

Overview The Select Loop button (Figure 5-16) allows you to select and simulate a configured loop in the
TrueSite Workstation. When you select a loop in simulation mode (Refer to Chapter 6 for details on
Point Simulate operation), you can view its status and control information and perform operations
from the Simulator window. The information presented in the Simulator window are identical to the
information presented in the Point Status & Control window. Events triggered for a specific loop in
simulation are only displayed in the Simulator window.

 Figure 5-16    Select Loop Button

Notes: 1. The Select Loop button is usable only when the Simulator tab is selected in the major tab 
area. You must activate the Simulator window in order to use the Select Loop button.

     2. Be advised that this particular Select Loop button does not perform the same operation as 
the Select Loop button found in the Network menu. The operation described in this section 
strictly concerns the selection of a loop in the simulation mode.

Select a Loop in 
Simulation Mode

When there are multiple loops installed in the TrueSite Workstation, you may choose to view the
events of a specific loop in simulation mode through the following procedure:

1. Click the Point Simulate tab in the major tab area to open it in the main window.
2. Click Select Loop in the Operations toolbar menu.
3. A Select Network Loop dialog box appears as shown in Figure 5-17.

 Figure 5-17    Select Network Loop Dialog (Point Simulate)

Note: By default, only Loop 1 should be selectable. Figure 5-17 represents the case where two
loops are configured in the TrueSite Workstation. You can configure up to four selectable
loops.

4. Under the “Network” list, check one of the enabled checkboxes next to the loop you are
selecting. (Greyed-out checkboxes are non-selectable.)

5. Click OK to confirm your selection.
6. The Simulator window will display a screen with status and control information for the loop you

have selected.
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Chapter 6. Utilities Menu

Introduction The following commands are available:
• Login
• Time and Date
• Configurator
• Network
• Site Info
• Point Simulate
• Quiet Sounder
• Restore All Windows

 Figure 6-1    Utilities Menu from Menubar and Toolbar Views

Note: To be able to access the Utilities toolbar menu, you must first activate it as follows: Right-click
the toolbar portion of the TrueSite Workstation interface. From the list of available toolbar
menus, highlight and select Utilities Toolbar. The Utilities menu should display on the
toolbar.

Utilities menu
from menubar

Utilities menu from toolbar
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Login

Overview The Login button (Figure 6-2) allows you to log-on to the TrueSite Workstation system. You can also
change your existing passcode through the Login or Log off dialog box.

 Figure 6-2    Login Button

Log on to TrueSite 
System

To log in, follow these procedures:

1. Click on Login in the Utilities toolbar. The Login dialog box appears as shown in Figure 6-3.

 Figure 6-3    Login Dialog

2. In the Login dialog provide the following information:
a. Enter your name/number using the digit buttons on the right.
b. Enter your secret passcode using the digit buttons on the right.

3. Click Log On. 

Notes: •  After you have successfully logged onto the TrueSite Workstation, the operator fields will 
be filled with the appropriate information.

•  Alternatively, you may access the Login command by pressing Ctrl + L on your keyboard.
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Login, Continued

Log Off To log off from the TrueSite Workstation, do the following:

1. While you’re logged in, click on Login in the Utilities toolbar. The Login dialog box appears as
shown in Figure 6-4.

 Figure 6-4    Login Dialog, Log Off

2. In the Login dialog, click Log Off.

Note: If the system is configured with an Inactivity Timeout, the system automatically logs off after a
given expiration time period (default is 30 minutes).

Change Passcode To change your passcode, do the following:

1. Click on Login in the Utilities toolbar. The Login dialog box appears.
2. In the Login dialog, click Change Passcode. A Passcode Change dialog box (Figure 6-5)

prompts you to change your passcode.

 Figure 6-5    Passcode Change Dialog

3. In the Passcode Change dialog, you must provide your current passcode and enter the new
passcode twice for validation.

4. Once you have provided this information, click OK. 
5. The passcode is changed.
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Time and Date

Overview The Time and Date button (Figure 6-6) allows you to change the time and date in the system.

 Figure 6-6    Time and Date Button

Set the Time and 
Date

1. From the Utilities toolbar menu, click Time and Date.
2. The Time and Date dialog box appears as shown in Figure 6-7. In this dialog, you may change

time and date settings as follows:

• To change the time, click on the spinner up/down arrows to increment or decrement the time 
value until the correct time value displays in the time field.

• To change the date, select the dropdown button to view the calendar and click a date. The 
selected date displays in the date field.

3. After making changes to the time and date, you have the following options:

• Click OK to confirm time and date changes and to close the Time and Date dialog.
• Click Apply to confirm time and date changes without closing the Time and Date dialog.
• Click Close to dismiss the Time and Date dialog.

 Figure 6-7    Time and Date Dialog
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Configurator

Overview The Configurator button (Figure 6-8) allows you to launch the TrueSite Workstation Configurator.

 Figure 6-8    Configurator Button

Note: The Configurator can only be used for limited functions when invoked from Run-time. In order
to use the full functioning Configurator, you must exit the Run-time and manually launch the
Configurator.

Launch 
Configurator

1. From the Utilities toolbar menu, click Configurator.
2. TrueSite Workstation Configurator launches with the current job as shown in Figure 6-9.

Note: Alternatively, you may access the Configurator command by pressing Ctrl + E on your
keyboard.

 Figure 6-9    TrueSite Workstation Configurator
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Network

Overview The Network button (Figure 6-10) allows you to launch the Network window.

 Figure 6-10    Network Button

Notes: 1. Alternatively, you may access the Network command by pressing F9 on your keyboard.

     2. Refer to Chapter 9 of this document for details on Network window operations.
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Site Info

Overview The Site Info button (Figure 6-11) allows you to view the Site Info window. There are three possible
configurations for the Site Info window:
• No Configuration
• Configured for a Graphic Screen
• Configured for Action Messages 100-105

 Figure 6-11    Site Info Button

Note: In the case when both Graphic Screen and Action Messages are configured, the Site Info
window will display the Graphic Screen.

Option: No 
Configuration

In the case where no graphic screen and action messages are configured, the Site Info button will be
disabled (greyed-out).

Option: Configured 
for a Graphic 
Screen

Notes: A graphic screen configured for Site Info can be created using the TrueSite Workstation Con-
figurator and saved under the filename: _SITEINF.WGS. To configure the Graphic Screen, 
follow this procedure.

     3. Launch the TrueSite Workstation Configurator.

     4. In the configurator, open an existing job or create a new job.

     5. To open an existing job, select and click File -> Open. The Job Directory dialog appears: 
select a job from the directory and click OK.

     6. To create a new job, select and click File -> New. The Create Job dialog appears: type the 
name of the job in the Job Filename field and click OK.

     7. After selecting the job, log on to the TrueSite Workstation Configurator (Refer to Chapter 
1).

     8. Once you are logged in, select Configure -> Graphics Editor.

     9. The Graphic Editor launches. In the editor, create a graphic.

     10. Save the graphic as follows: select File -> Save as...

     11. The Save Document dialog appears. Under the Name field, type “_SITEINF” and click 
OK. The graphic screen you have created will be saved under the WGS format.

     12. Exit the Editor.

     13. In the next step, you need to build the current job. To do so, select Utility -> Job Builder, 
and click Build.

     14. Exit the TrueSite Workstation Configurator and launch TrueSite Workstation.

Continued on next page
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Site Info, Continued

Option: Configured 
for a Graphic 
Screen, Continued

Click Site Info to bring up the configured graphic screen under the Graphics window. Figure 6-12
shows an example of a site info graphic screen that displays an overview of the site.

 Figure 6-12    Example of Site Info Configured for a Graphic Screen

Continued on next page
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Site Info, Continued

Option: Configured 
for Action 
Messages

The operator may want to list Action Messages in order to provide specific customizable information
about the site. This provides a quick link for some non-obvious information to the operator that will
serve as a help file for the site.

Notes: Up to six action messages for Site Info can be configured using the TrueSite Workstation 
Configurator. To configure the Actions Messages, follow this procedure.

     1. Launch the TrueSite Workstation Configurator.

     2. In the configurator, open an existing job or create a new job.

•  To open an existing job, select and click File -> Open. The Job Directory dialog appears: select a 
job from the directory and click OK.

•  To create a new job, select and click File -> New. The Create Job dialog appears: type the name of 
the job in the Job Filename field and click OK.

     3. After selecting the job, log on to the TrueSite Workstation Configurator (Refer to Chapter 
1).

     4. Once you are logged in, select Configure -> Action Messages.

     5. Action Message Editor (Figure 6-13) launches. You can configure action messages by 
double-clicking on the Message Label field of messages numbered between 100 and 105. 

 Figure 6-13    Action Message Editor (in TrueSite Workstation Configurator)

     6. After double-clicking the Message Label field of a specific message, a dialog prompts you 
to type in a custom text in the input field. Your input text is limited to a maximum length of 
25,000 characters. After entering the text, click OK.

     7. Click Save to save Action Messages.

     8. Exit the Editor.

     9. In the next step, you need to build the current job. To do so, select Utility -> Job Builder, 
and click Build.

     10. Exit the TrueSite Workstation Configurator and launch TrueSite Workstation.

Continued on next page
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Site Info, Continued

Option: Configured 
for Action 
Messages, 
Continued

Click Site Info to bring up the configured action messages in Site Info window. Figure 6-14 shows
an example of a site info screen with four configured action messages.

 Figure 6-14    Example of Site Info Screen Configured for Action Messages
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Point Simulate

Overview Note: When the TrueSite Workstation is configured as a supervising station (4190-8403), it cannot
be allowed to be taken offline. Thus, the Point Simulate operation is not available to TrueSite
Workstation configured as supervised stations.

The Point Simulate button (Figure 6-15) provides access to the Simulator window. This allows you
to take the system offline to simulate events in real time within a specific network loop. In simulation
mode, the system will only display its responses towards events without affecting the TrueSite
Workstation.

 Figure 6-15    Point Simulate Button

Note: Alternatively, you may access the Point Simulate command by pressing F8 on your
keyboard.

Enter Simulation 
Mode: Select a 
Loop

When the TrueSite Workstation enters simulation mode, it disconnects from the network without
breaking the network loop. This allows the operator to manipulate the states of external points locally.
Without changes seen elsewhere on the loop, TrueSite Workstation will treat changes performed in
simulation mode as real. However, results from events occurring in this mode will not be carried over
in the real environment.

In order to enter the simulation mode, you must first select a loop through this procedure:
1. From the Operations menu, click Select Loop. A Loop Selection dialog appears.
2. In the dialog, select the checkbox next to an available loop and click OK.
3. The system enters simulation mode.

Exit Simulation 
Mode: Un-select a 
Loop

Warning:  Once you select a loop, the system will remain in simulation mode until you set it back to 
real mode by deselecting the loop.

To exit simulation mode in order re-enter real mode, you must deselect the loop through the following
procedure:

1. From the Operations menu, click Select Loop. A Loop Selection dialog appears.
2. In the dialog, deselect the checkbox next to present loop and click OK.
3. The system re-enters real mode.

Note: In case a real alarm occurs, the TrueSite Workstation will exit simulation mode and display
the real alarm within any network loop.

Continued on next page
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Point Simulate, Continued

Simulate Points Notes: 1. The Simulator window is an exact match of the Status & Control window.

     2. Point Simulate operation is not supported for DACR or 2120 points.

Once you select a loop and the system enters simulation mode, you can control and view points from
the Simulator window (Figure 6-16).

 Figure 6-16    Simulator Window

To access the Status and Control dialog to configure any point in simulation mode, double-click it in
the Simulator window. Depending on the desired behaviour of the point within the simulation
environment, configure it using the Control tab in the dialog. In the case of an external point,
additional behaviour can be configured through the Simulate tab.
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Quiet Sounder

Overview The Quiet Sounder button (as shown in Figure 6-17) silences the PC sounder without
acknowledging an alarm signal. This operation is defaulted to access level 7 (Service Mode).  Lower
access levels are configurable, but are restricted to when the TrueSite Workstation is not programmed
for Individual Acknowledge. For UL compliant configurations, refer to table located in Configuration
section of Chapter 1.

 Figure 6-17    Quiet Sounder Button

Note: Alternatively, you may access the Quiet Sounder command by pressing F7 on your
keyboard.

Sounder Properties There are two cases when the sounder is triggered:
• When a new alarm event occurs, the sounder is triggered. This is always the case regardless of

whether or not there were previously unacknowledged alarm signals.
• The second case occurs when an alarm signal has been silenced but remains unacknowledged. If the

alarm remains unacknowledged after a five-minute time-out period, its sounder is triggered again.
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Restore All Windows

Overview The Restore All Windows command sets all windows that are configured to dockable and floating
mode to fixed mode in the main window area.
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Chapter 7. Historical Log Menu

Introduction The Historical Log menu contains operations that allow you to navigate through the History and
Operator Logging Window introduced in Chapter 4. Mainly, the Historical Log menu as shown in
Figure 7-1, provides six options:
• Change View
• Change Volume
• Volume Operation
• Operator Notes
• Find
• Find Next

 Figure 7-1    Historical Log Toolbar Menu

Note: 1. To be able to access the Historical Log toolbar menu, you must first activate it as follows: 
Right-click the toolbar portion of the TrueSite Workstation interface. From the list of avail-
able toolbar menus, highlight and select Historical Log Toolbar. The Historical log menu 
should display on the toolbar.

     2. TrueSite Workstation Run-time activates the Historical Log toolbar menu whenever the 
Historical Log window is active in the main window area.

Historical Log menu from menubar

Historical Log menu from toolbar
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Overview The Change View button (Figure 7-2) allows you to change the display conditions of the grid in the
Historical Log window.

 Figure 7-2    Change View Button

The Change Volume button (Figure 7-3) allows you to manipulate the log in order to view a selected
portion of the historical log. By default, there are two volumes.

 Figure 7-3    Change Volume Button

Change Historical 
Log Display 
Conditions

To change the Historical Log display conditions:

1. Click the Historical Log in the major tab area to bring up its content in the main window.
2. From the Historical Log toolbar menu, click Change View.
3. The Historical Log/Volume Operation dialog box appears as shown in Figure 7-4.

 Figure 7-4    Historical Log/Volume Operation Dialog

Note: At any time, you may click Cancel to dismiss the dialog without taking any action.

4. You must select a volume and a view in the corresponding lists:
a. To select a volume, click and highlight an entry in the “Volume” list.
b. To select a view, select and highlight an entry in the “View” list.

5. After selecting a volume and a view, click OK. The Historical and Operator Logging Window
should update to the new display conditions.

Continued on next page

Change View / Change Volume
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Change View / Change Volume, Continued

Edit a View Note: The following procedures only concern the scenario where the selected view is editable.
Editable views are originally UNUSED and are customizable. Default views that are pre-
programmed cannot be edited.

To edit a view:

1. Select an entry from the “View” list in the Historical Log/Volume Operation dialog box.
2. Click EDIT VIEW. A Custom View Configurator dialog box appears as shown in Figure 7-5.

 Figure 7-5    Custom View Configurator Dialog

Note: At any time, you may click Cancel to dismiss the dialog without taking any action.

3. In the Custom View Configurator dialog, you must set the following parameters:

• Custom View Name - Enter an alphanumerical string.
• Core View - Select one of the following options from the dropdown list:

- Entire
- Fire Alarm
- Priority2 Alarm
- Supervisory
- Trouble
- Control
- Diagnostic
- Operator

• Time Range - Enter the From and To values in the following format (hh/mm/ss) to set a range.
• Date Range - Enter the From and To values in the following format (yy/mm/dd) to set a range.

Continued on next page
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Change View / Change Volume, Continued

Edit a View, 
Continued

Note: Step 4 is optional and is used to modify advanced view settings. You may bypass this step.

4. Click Advanced. The Advanced View Options dialog appears as shown in Figure 7-6. From this
dialog, you can include points by selecting the checkboxes and providing a string for the
following parameters (Click OK to confirm entries):

• Network
• Node
• Point Name

 Figure 7-6    Advanced View Options Dialog

Note: At any time, you may click Cancel to dismiss the dialog without taking any action.

5. Finally, click OK to confirm new display settings.

Erase a View To erase a view:

1. Select an entry from the “View” list in the Historical Log/Volume Operation dialog box.
2. Click REPLACE WITH UNUSED VIEW. A prompt dialog will ask you “Do you really want

to ERASE view?”.
3. Click OK to confirm. The view is erased from the list.
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Volume Operation

Overview The Volume Operation button (Figure 7-7) allows you to open the Historical Log Volume Operation
dialog box (shown in Figure 7-8) which lists existing historical log volumes and provides the
following options:
• Label
• Delete
• Export
• Backup
• Restore
• Return
• Close Active Volume

 Figure 7-7    Volume Operation Button

 Figure 7-8    Historical Log Volume Dialog

Note: 1. At any time, you may click CLOSE to dismiss the dialog without taking any action.

     2. At any time, you may click CLOSE ACTIVE VOLUME to close the active volume.

Continued on next page
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Volume Operation, Continued

Label a Volume 1. In the Historical Log Volume Operations dialog, select and highlight a label from the list under
“Volumes”.

2. With the selected volume highlighted, click LABEL.
3. A Change Volume Label dialog box appears as shown in Figure 7-9. From this dialog, enter the

new label under the “New volume label” text field.

 Figure 7-9    Change Volume Label Dialog

4. Click OK to confirm label change.

Note: At any time, you may click Cancel to dismiss the dialog without taking any action.

Delete a Volume Note: 1. You can only delete a volume that is not currently being viewed.

     2. TrueSite Workstation does not allow you to delete a volume that still has active unacknowl-
edged signals.

1. To delete a volume, select and highlight a label from the list under “Volumes”.
2. With the selected volume highlighted, click DELETE. A prompt dialog will ask you “Are you

sure you want to delete the highlighted volume?”.
3. Click Yes to confirm.

Export a Volume 1. In the Historical Log Volume Operations dialog, select and highlight a label from the list under
“Volumes”.

2. With the selected volume highlighted, click EXPORT.
3. A Export Volume Label dialog box appears as shown in Figure 7-10. From this dialog, set the

following parameters:

• Filename - Enter an alphanumerical string. (By default, this field is “HLEXPORT.TXT”)
• File format - Select one of the following two options by selecting the corresponding radio 

button:
- ASCII Text (Default)
- Comma Delimited Text

Note: You may select a drive other than A:\ to export a volume by simply inserting it at the front of
the filename. For example: “C:\HLEXPORT.TXT”.

Continued on next page
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Volume Operation, Continued

Export a Volume, 
Continued

 Figure 7-10    Export Volume Label Dialog

4. Once you have configured the export settings, click OK.
5. The volume is exported according to settings.

Backup a Volume Note: You should make sure to label your backup disks for simple reference in case you need to
restore a volume.

1. Insert a compact disk (CD) into the d:\ drive.
2. In the Historical Log Volume Operations dialog, select and highlight a label from the list under

“Volumes”.
3. With the selected volume highlighted, click BACKUP.
4. A Backup Volume dialog box appears as shown in Figure 7-11. 

 Figure 7-11    Backup Volume Dialog

5. From this dialog, provide the filename of the backup log.
6. Click OK. 
7. The volume log is backed-up in the CD.

Note: You may select a drive other than d:\ to backup a volume by simply inserting it at the front of
the filename. For example: “C:\HLEXPORT.TXT”.

Continued on next page
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Volume Operation, Continued

Restore a Volume 1. Insert a storage media (USB key or CD) with the backup file into the appropriate drive or port.
2. In the Historical Log Volume Operations dialog, select and highlight a label from the list under

“Volumes”.
3. With the selected volume highlighted, click RESTORE.
4. A Restore Volume dialog box appears as shown in Figure 7-12. 

 Figure 7-12    Restore Volume Dialog

5. From this dialog, provide the filename of the backup log you want to restore.
6. Click OK. 
7. The volume log is restored

Note: You may select a drive other than A:\ to restore a volume by simply inserting it at the front of
the filename. For example: “C:\HLEXPORT.TXT”.
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Operator Notes

Overview The Operator Notes button (Figure 7-13) allows you to add notes to a volume.

 Figure 7-13    Operator Notes Button

Add a Note to an 
Event

To add a note to an event in the Historical Log:

1. Click Historical Log in the major tab area to bring up its content in the main window.
2. Select and highlight an event from the list within the main window.
3. From the Historical Log toolbar menu, click Operator Notes.
4. The Add Operator’s Note dialog box appears as shown in Figure 7-14.

 Figure 7-14    Add Operator’s Note Dialog

5. Under “Associate Note With”, select the Highlighted Event radio button.
6. From this dialog, type a note in the main field to be associated with the highlighted event.
7. Once you have finished, click OK.
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Find / Find Next

Overview The Find button (Figure 7-15) allows you to search the list of system points by matching one of the
three options:
• by point name
• by point label
• by text

The Find Next button allows you to view the next point in the list.

 Figure 7-15    Find and Find Next Buttons

Note: Alternatively, you can press Ctrl+F and F3 to access the Find and Find Next operations
respectively.

Find a specific 
point

To find a point, do the following:

1. Click the Historical Log tab in the major tab area to bring up its content in the main window.
2. From the Historical Log toolbar menu, click Find.
3. The Find Selected Point dialog box appears as shown in Figure 7-16.

 Figure 7-16    Find Selected Point Dialog

4. From this dialog, type in either port name, label or text of a point you want to find.
5. Select one of the following search options by clicking the radio button next to it:

• By Point Name
• By Point Label
• By Text

6. Click OK.

Note: At any time, you may click Cancel to dismiss the dialog without taking any action.
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Chapter 8. Reports menu

Introduction The Reports menu allows you to generate, view and print reports on specific events occurring within
the system network. As shown in Figure 8-1, five operations are available from this menu:
• Generate
• View
• Close View
• Terminate
• Printer Control

 Figure 8-1    Reports menu from Menubar and Toolbar Views

Notes: 1. To be able to access the Reports toolbar menu, you must first activate it as follows: Right-
click the toolbar portion of the TrueSite Workstation interface. From the list of available tool-
bar menus, highlight and select Reports Toolbar. The Reports menu should display on the 
toolbar.

     2. By default, the TrueSite Workstation Run-time activates the Reports toolbar menu when-
ever the Reports window is active in the main window area. You may choose to hide the 
toolbar menu.

Reports menu
from menubar

Reports menu from toolbar
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Overview The Generate button (Figure 8-2) allows you to generate five types of reports:
• Historical Log Report
• TrueAlarm Service Report
• TrueAlarm Status Report
• AMZ Calibration Report
• Active List Report

 Figure 8-2    Generate Button

The Terminate button (Figure 8-3) allows you to terminate an ongoing report generation.

 Figure 8-3    Terminate Button

Generate a Report 1. From the Reports toolbar menu, click Generate.
2. The Report Selection dialog box appears as shown in Figure 8-4.

 Figure 8-4    Report Selection Dialog

3. From this dialog list, select and highlight the type of report you want to generate. With the report
type highlighted in the list, you may pursue the following options:

• To generate a report, click Generate within the Report Selection dialog box. If a report of the 
same type already exists, a File Mode dialog appears as shown in Figure 8-5. You must 
choose one of the following options:

- Click Cancel to terminate report generation.
- Click Append to append the current report to the existing report of the selected type.
- Click Delete to replace the existing report of the selected type with the current generated report.

Continued on next page

Generate / Terminate
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Generate / Terminate, Continued

Generate a Report, 
Continued

 Figure 8-5    File Mode Dialog

• To change the report target, or change the report file name, click Target within the Report 
Selection dialog box. A Report Selection dialog box appears as shown in Figure 8-6.

- To change the report target, select and highlight the name of new target from the list. Click OK.
- To change the report file name, click in the Filename input field and manually enter the new 

file name using the keyboard. Click OK.

 Figure 8-6    Report Target Dialog

Note: At any time, you may click Cancel to dismiss the dialog without taking any action.

Terminate a Report 
Generation

While a report is currently being generated, click on Terminate on the Reports menu to end the
generation. 

Notes: •  It will finish generating the current report and terminate all remaining ones.
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View / Close View

Overview The View button (Figure 8-7) allows you to access the View Report dialog box. By default, the View
button is enabled. Once clicked, it becomes disabled and the View Report dialog displays a list of
pending reports

The Close View button (Figure 8-7) allows you to switch from the View Report dialog box to the
View Content dialog. By default, the Close View button is disabled.

 Figure 8-7    View (Enabled) & Close View (Disabled) Buttons

Note: When Close View is enabled, all other View Toolbar buttons are disabled and vice-versa.

View Report Dialog 1. From the View toolbar menu, click View.
2. The Report dialog box appears as shown in Figure 8-8. From this point, you may pursue the

following options:
• To view a report, click on its file name from the displayed list. Once the name is high-

lighted, click OK.
• To delete a report, click on its file name from the displayed list. Once the name is high-

lighted, click DELETE.

 Figure 8-8    View Report Dialog

Note: At any time, you may click Cancel to dismiss the dialog without taking any action.

Close a Report If the main window displays a report, click Close View on the Reports menu to close the report.
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Printer Control

Overview The Printer Control button (Figure 8-9) allows you to flush the printer buffer. This task is useful
when there is a jam at the printer.

 Figure 8-9    Printer Control Button

Flush the Printer 
Buffer

1. From the Reports toolbar menu, click Printer Control.
2. The Flush Printer Buffer dialog box appears as shown in Figure 8-10.
3. Click and highlight the printer from the list of printers you want to flush.
4. Once the printer has been highlighted, click Flush Buffer.

 Figure 8-10    Flush Printer Buffer Dialog
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Chapter 9. Network Menu

Introduction The Network menu allows you to administer network activity through the following main operations:
• Topology
• Attendance
• Select Loop
• Host Diagnostics

 Figure 9-1    Network Menu from Menubar and Toolbar Views

Notes: 1. To be able to access the Network toolbar menu, you must first activate it as follows: Right-
click the toolbar portion of the TrueSite Workstation interface. From the list of available tool-
bar menus, highlight and select Network Toolbar. The Network menu should display on 
the toolbar.

     2. TrueSite Workstation Run-time activates the Network toolbar menu whenever the Network 
window is active in the main window area.

Network menu
from menubar

Network menu from toolbar
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Overview The Topology button (Figure 9-2) allows you to view the representation of the connections between
nodes in the system which are communicating with the TrueSite Workstation (this node). All nodes
are displayed relative (left or right) to all other nodes currently online.

Notes: 1. A node that has lost communication but that was previously online will be crossed out 
(marked with an “X”).

     2. Either Topology or Attendance is always selected (not both); the selected option is high-
lighted/selected in the menubar/toolbar.

 Figure 9-2    Topology Button

View Network 
Topology

Note: By default, when you click Network from the View menu, the Network window displays the
Topology screen activated under Network Information minor tab.

To view network topology:
1. Click Topology from the Network menu.
2. The network topology diagram displays in the Network window as shown in Figure 9-3.

 Figure 9-3    Network Topology

In the Network window, the different types of nodes are represented by graphical icons. In some
cases, these icons are accompanied by one of the following labels to specify their roles:
• * - host node
• T - timekeeper node
• L - left node
• R - right node
• M - monitor node
• C - client node

Continued on next page

Topology
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Topology, Continued

View Network 
Topology, 
Continued

3. From the Network window, you can perform the following operations by clicking the buttons at 
the lower-left corner of the main window:

• To view node information: select a node in the network topology diagram and click About 
Node. The About Node dialog appears as shown in Figure 9-4.

• To view channel status: select a node in the network topology diagram and click Channel 
Status. The Channel Status Information dialog appears as shown in Figure 9-5.

Note: Alternatively, you can use your mouse to access About Node function of a node by double-
clicking a specific point in the network topology diagram.

 Figure 9-4    About Node Dialog

A channel is a network resource available network-wide for use by Terminal Mode, Network
Download and Diagnostics for data transfer between nodes. 

The Channel Status function allows you to verify the availability of network resources which are
currently being requested for a specific node. It shows whether or not they are currently being used by
other nodes, thus preventing the requesting node from successfully accessing a data channel.

The following information is displayed about a channel’s status.
• Network Number - number assigned to the network in the Network Programmer
• Network Title - title assigned to the network in the Network Programmer
• Host Logical Node # - node number specific to the TrueSite Workstation
• Host Physical Node # - node number specific to the TrueSite Workstation
• Operations status - normal (default) or abnormal

 Figure 9-5    Channel Status Information Dialog
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Attendance

Overview The Attendance button (Figure 9-6) allows you to analyze the attendance of the devices within the
network. The network attendance diagram represents the configured nodes in the network.

Notes: 1. A node that has lost communication but that was previously online will be crossed out 
(marked with an “X”).

     2. Either Topology or Attendance is always selected (not both); the selected option is high-
lighted/selected in the menubar/toolbar.

 Figure 9-6    Attendance Button

View Network 
Attendance

To view network attendance:
1. Click Attendance from the Network menu.
2. The network attendance diagram displays in the Network window.
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Select Loop

Overview The Select Loop button (Figure 9-7) allows you to change from one network loop to another. This
operation is available only if the job is multi-loop.

 Figure 9-7    Select Loop Button

Notes: 1. The Select Loop button is usable only when the Network tab is selected in the major tab 
area. You must activate the Network window in order to use the Select Loop button.

     2. Be advised that this particular Select Loop button does not perform the same operation as 
the Select Loop button found in the Operations menu. The operation described in this sec-
tion strictly concerns the selection of a loop in real mode.

Select a Network 
Loop in Real Mode

When there are multiple loops configured in the TrueSite Workstation network, you may choose to
view the information for a specific loop:

1. Click the Network tab in the major tab area to open it in the main window.
2. Click Select Loop in the Network toolbar menu.
3. A Select Network Loop dialog box appears as shown in Figure 9-8.

 Figure 9-8    Select Network Loop Dialog (Point Simulate)

Note:  By default, only Loop 1 should be selectable. Figure 9-8 represents the case where two 
network loops are configured in the TrueSite Workstation. You can configure up to four 
selectable loops.

4. Under the “Network” list, check one of the enabled checkboxes next to the loop you are
selecting. (Greyed-out checkboxes are non-selectable.)

5. Click OK to confirm your selection.
6. You now have access to the information for that specific loop under network minor tabs. All

changes performed in the minor tabs will affect the status of the selected network loop.
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Host Diagnostics

Overview The Host Diagnostics button (Figure 9-9) allows you to monitor a network and its host
communication.

 Figure 9-9    Host Diagnostics Button

View Host 
Diagnostics

To view host diagnostics
1. Click Host Diagnostics from the Network menu.
2. The Host Diagnostics dialog displays in the Network window as shown in Figure 9-10.

 Figure 9-10    Host Diagnostics Dialog

Start Messages Clicking Start Messages creates a connection to the network to enable network monitoring. The
messages relayed present network diagnostic statistics.

Stop Messages Clicking Stop Messages causes the system to stop receiving information without clearing the existing
messages.

Clear Tallies Clicking Clear Tallies removes the current information from the Network Diagnostics dialog without
stopping the system from updating information.

Exit Clicking Exit clears all information and stops the current network connection.



9-7

Minor Tab Buttons

Overview When the major Network tab is selected in the major tab area, the Network section is displayed in the
main window with three buttons on the minor tab area (Figure 9-11):
• Network Information
• Terminal Mode
• Network Download

 Figure 9-11    Minor Network Tab Bar

Network 
Information

By default, when you click Network from the View menu, the Network window displays the
Topology screen with Network Information minor tab selected. Under this tab, you can perform all
the commands described earlier in this chapter.

Terminal Mode Click Terminal Mode minor tab to activate its options. Under this tab (Figure 9-12), two commands
are available:

 Figure 9-12    Active Terminal Mode Minor Tab

Continued on next page
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Minor Tab Buttons, Continued

Terminal Mode, 
Continued

• To open a session:
1. Click Open Session to access Open Session dialog.
2. In the list of nodes presented in the dialog, highlight the node for which you want to open a 

session and click OK.
3. The Open Session dialog closes.
4. You can monitor the progress of the session in the main window under the Terminal Mode 

minor tab until progress is complete.
• To terminate a session, click Terminate Session.

Network Download Under the Network Download minor tab (Figure 9-13), you can download network nodes onto the
system. To do so, follow this procedure:
1. Click Network Download. A Network Download Operation dialog appears as shown in Figure 

9-14.

 Figure 9-13    Active Network Download Minor Tab

 Figure 9-14    Network Download Information Dialog

Continued on next page
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Minor Tab Buttons, Continued

Network Download, 
Continued

2. From the Network Download dialog, two actions are available:

• To download a node, highlight and select the node you want to download from this dialog, 
then click OK.

• To view information of a job, highlight and select it, then click More Info. The Job 
Information Dialog appears as shown in Figure 9-15.

 Figure 9-15    Job Information Dialog

3. After selecting a job to download from the list, job download progress can be monitored in the 
main window as shown in Figure 9-16 under the Network Download minor tab. To interrupt and 
cease a download, click Abort.

 Figure 9-16    Monitoring Network Download in Main Window
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